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THE INTEGRATION OF GPS, EXPERTGPS, EXCEL, AND ARCGIS IN GEOLOGICAL MAPPING AND DATA MINING

SUMMARY
1) Set up a working directory (e.g. arccampus) to include the following folders:
Airphoto  - for airphoto images,

Excel      - for EXCEL (.XLS and .DBF) and ExpertGPS (.gpx) files, including the .xls masterfile.

rectify     - for rectified images.

shape     - for ArcGIS shapefiles.

layer       - for ArcGIS layers.

ref_pnts  - for reference points used to georegister the airphoto.


  2) Load and set preferences in ExpertGPS, and install the airphoto from the map/photo library (OPTIONAL). Georegister the airphotos if they are unregistered JPG's.

               3) Setup grid and scale variables, and make hard copies of the airphotos.


  4) Collect field data.

5) Download waypoints and save to a .gpx file.

6) Set columns and export waypoints to a .txt file.

7) Load the .txt file (and PERSONAL.XLS file) into Excel, add ‘outcrop’ ‘Traverse’ and

   ‘Geologist’ fields and run the Garmin Macro to reformat the fields.

8) Copy the data set to the master database file.

9) Add structural (strike, dip, plunge, younging), lithological, chemical, etc, data to the EXCEL master folder, and save the master file as both .xls and .dbf


10) Load ARCGIS and assign the correct map projection to the data frame.


11) Add the airphotos to the ARC MAP document

( In the case of the Sudbury region: see http://www.city.greatersudbury.on.ca/pubapps/ortho/index.cfm?lang=en&option=indexmap
The orthophotos can be downloaded as MrSid files and added directly to an ArcGIS document without any need to georeference).


12) Add the EXCEL .dbf data file to the ARC MAP document, and create 'outcrop number' labels for the data points.


13) Add the structural data to the ARC MAP document.


14) Setup the Symbiology and Labels to be used in plotting oriented symbols for the various structural 'features' (bedding, foliation, dikes, younging).


15) Setup the shape files and layers to be used in drawing geological boundaries and creating lithologic polygons.


16) On the 'all line' layer draw in the lines representing geologic boundaries.


17) Create polygons on an ‘allpolygon’ layer from the lines in the Lines shape file using ET Geowizards (see http://www.ian‑ko.com/  ‑ ET Geo Wizards).


18) Copy and Paste the polygons sets representing different lithologies from the ‘allpolygon’ layer to their relevant lithologic layer.

Acronyms: DC = double click (Layer Properties); RC = right click; TB = Toolbar; TOC = Table of contents.

PROCEDURE

SETTING UP FOLDERS

Create a folder ‘arc_campus’ for the project, and within ' arc_campus ' create:

a sub folder 'airphoto' for the airphoto images,

a subfolder EXCEL to archive the .gpx, .xls, dbf files generated in Excel (coordinate data originally from ExpertGPS). Copy the EXCEL master folder .dbf to the EXCEL folder.

a sub_folder rectify for the rectified image

a sub_folder shape for the rectified image

a sub_folder ref_pnts for the reference points used to georegister the image

a sub_folder layer for layers generated in ARCGIS9

COLLECT DATA

ExpertGPS

DOWNLOADING WAYPOINT DATA FROM THE GPS UNIT

Load ExpertGPS (START ‑> PROGRAMS ‑> EXPERTGPS), and in FILE ‑> Preferences set the parameters for the download, e.g. Brunton or Garmin Etrex ; input port as COM1 or COM2; the path to the folder containing the data, e.g c:\arc_campus\excel.  Units of measure, e.g. Metres; Coordinates, e.g. Decimal degrees, WGS84 datum; making sure to check the 'Use UTM coordinates' box.

Connect the COM1 serial cable to the Brunton/Garmin. (If using a Belkin RS232 to USB converter, the Belkin unit must be attached and the Belkin drivers loaded before turning on the computer.)

Turn on the Garmin. (When downloading from the Brunton, both the Brunton and the GPS function must be ON; if the first attempt to download fails, try a second time.)

In ExpertGPS click the receive 'Waypoints from GPS' icon; check the Waypoints box; click OK.  The data will be downloaded from the Garmin\Brunton to EXPERTGPS. Save the data as a .gpx file in c:\arc_campus\excel.

MANIPULATING THE DATA IN EXCEL

Export the data from ExpertGPS (File ‑> Export ‑> Save As ‑> Enter) as a .txt file, e.g. campus.txt, to 'c:\arc_campus\excel'.

Open the file campus.txt in Excel. 

In column 8 add the string  ‘outcrop’, in column 9 add a Traverse ('Travnum') field with the value, e.g. 3090127 (3 = year, 09 = month, 01 = student [a number will be assigned to you], 27 = day) entered into all the cells, and in column 10 add a 'Geologist' field with the numerical value that has been assigned to you, e.g. '1', in all rows. Save the file.

The columns and cell values can now be manipulated into a form suitable for import into Fieldlog by running an EXCEL macro that will carry out the manipulation.

EXCEL MACRO 


Load into EXCEL the supplied file personal.xls 

Run the Garmin macro by selecting TOOLS ‑> Macro ‑> Macros ‑> Personal.XLS!Garmin (or Brunton). The macro is contained in the  'personal.xls' file.

The macro will create a STATION field numeric value in which each value will have the form, e.g. 309012701, where 3 = the year 2003, 09 the month, 01 = the geologist, 27 = the day, and 01 = the order in which the stations (outcrops) were collected on that day.

Load the file campus.xls into EXCEL and Cut and Paste the modified data set into the STATI Table section (1st Table) of campus.xls.  This will provide you with an EXCEL record of your data set that you can subsequently upgrade with information from your field notes as needed.

In the master file the data is organized as a set of fields (columns) grouped into a set of Tables. The Table and Field order is:

STATI: Statnum, UTMX, UTMY, UTMZ, Long, Lat, Elevation,  Statype, Travnum, Geologist, Airphoto, Outcrop, Sketch/Photo, Comment, and UTM Zone.  (The Elevation field is not used in this exercise.)

STRUCTURE: Statnum, UTMX, UTMY, STRUCFEATURE, Azimuth, Dip, Top direction

TRAVERSE: Statnum, NTS Map, Field dates, Summary

LITHOLOGY: Statnum, Rock #, Rock Type, Metals, Weathered colour, Fresh Colour, Describe, Comments

SAMPLE: etc

Add your structural and lithologic data to the .xls master file.

In the campus.xls file do a Format ‑> Column ‑> Autofit on the columns and save the file as an XLS file.  Delete the first row and make sure that all the records in any given column are of the same type. Save the modified file as, e.g. 'campus.dbf'.

ARCMAP


‘THE ESSENTIALS’:


Airphotographs are added using the ‘ADD’ tool.


The EXCEL database is added as an ‘…..Event’ layer using the ‘Add XYdata’ tool.

Symbols (waypoints, bedding, foliation, joints, dikes, etc) are added by exporting shape files via the ‘…..Events’ layer.

Line and Polygon layers (geologic boundaries, faults, lithology polygons) are added using the ‘New’ ‘shapefile’ function in ArcCatalog.


Lines are added using the Edit and Draw tools.

Polygons are created using the ArcGIS Editor and either the ETGeoWizard tool or the ArcGIS Topology tool.

ADDING AIRPHOTO IMAGES TO ARCMAP


Load ARCMAP

Optionally change the name of the data frame from 'Layers' to a recognizable name such as 'Campus'. 

DC the Layer icon in the TOC to get the 'Data Frame Properties'. Click the tab 'Coordinate System' ‑> Predefined ‑> 'Projected Coordinate systems' to set the coordinate system. Click APPLY and OK.

Click the ADD icon, select the name of the aerial photo to be loaded (e.g. campusgrd, and click ADD (or drag and drop the airphoto shapefile from the ARCGIS CATALOG).

If the image is a .geotiff or MrSid, the image will already be georeferenced, and nothing further needs to be done. If the image is a JPG image then use the Georeference tool bar to georeference and rectify the image as follows:

Click the 'View Link Table" icon to load the Link Table. Click the 'Add Control Points' icon and without moving the cursor click twice (do not double click) to add a control point to the table. Repeat to add a second and third (fourth, fifth, etc) control point. Enter manually (can also cut and paste) the known UTM  XMap and YMap coordinates of the image, and then click OK. In the 'Georeferencing' drop‑down list select 'Rectify', and save the new .tif image as 'reccampus' in \arc_campus\rectify.  The georeferencing changes will be permanent in the rectified image, but not in the original image archivd in \arc_campus\airphoto.   ADD 'reccampus' to the TOC, and remove the original jpg image.  Repeat for any other images.

TO PRINT THE AIRPHOTO WITH A GRID AND TO SCALE ON 11 X 8.5 PAPER

DC 'Layers' in the TOC to get the DATA FRAME PROPERTIES. Click the GRIDS tab ‑> New Grid ‑> Measured Grid and follow the instructions to set up the grid..

In DATA FRAME PROPERTIES select 'Data Frame' and in 'Extent' change 'Automatic' to 'Fixed Scale', adding a value of 1: 10000. 

Click the Layout View icon to enter Layout View.  The image can be moved within the limits of the 11 x 8.5 inch page by using the PAN tool. 

PLOTTING STATION SYMBOLS AND LABELS FROM A STATION (STATI) .DBF FILE

Load ARC Map and the relevant document, and in 'Tools' ‑> 'Add X Y data' and in 'Add XY data' browse and select 'campus.dbf'.  SpecifyUTMX and UTMY as the X and Y coordinates, respectively, and indicate the coordinate system to be used by clicking the Edit button ‑> Select ‑> Projected Coordinate systems ‑> UTM ‑ NAD83 17. Click ADD and then Apply and OK. 

'campus Events' will appear in the TOC. 

RC ‘campus Events' and select DATA ‑> Export data.  Export the new shape file as 'stati.shp' to \campus\shape.  When asked “Do you want to add the exported data to the map as a alayer, answer ‘YES’.

To add an 'Outcrop number' as a label, DC 'stati’  to get the 'Layer Properties'. Select 'Labels' ‑> check the 'Label features in this layer box ‑> select 'Label all the features the same way' as the 'Method' ‑> select OUTCROPNUM as the 'Text String Label Field' (OR STATNUM for the full station identifier). In the Placement Properties option box select low for 'Label Weight' and check 'Place overlapping labels'. Click APPLY and then OK if the plot is satisfactory.

SETTING THE REFERENCE SCALE

Double click the ‘campus’ layer to get the 'Layer Properties', and enter '0' as the value in 'Reference scale'. The plotted symbols will now remain the same size no matter the scale of the image. The symbol size will be that set in the 'Symbol Selector' (click the relevant symbol in the TOC to get to the 'Symbol Selector'). Now RC the image (not the symbols) and then 'Reference Scale' ‑> 'Set Reference Scale'.  The reference scale will be set to the current scale of the image. Now as you change the scale of the image, the size of the symbols changes; zoom in and the symbols will get larger. To revert to the original size of the symbols, RC the image and press the 'S' key twice.

PLOTTING STRUCTURAL SYMBOLS FROM A STRUCTURE (STR) .DBF FILE

RC 'campus Events' and select DATA ‑> Export data.  Export the new shape file as c:\arcampus\shape\'bedding.shp'. When asked “Do you want to add the exported data to the map as a alayer, answer ‘YES’.

Repeat to create .shp files for 'foliation1', foliation2, etc, and 'trap_dikes', or any other structural feature in the  'campus.dbf' file.

GROUPING LAYERS

The various structural layers can be grouped as a 'Structure Layers' Group by right clicking 'Layers' in the TOC and selecting 'New Group Layer'.  Click and drag the layers into the Group layer. Now turning off the Group Layer will turn off all the structure layers even if they are turned on individually.

PLOTTING STRUCTURAL SYMBOLS

DC 'bedding' to get 'Layer Properties'. Select Symbiology ‑> Categories ‑> Unique values.

In the values field select STRUCFEATU . Unselect the ‘All other values’ check box, click the ‘Add Value’ button and add the value 'subd' to the box.  Double click the symbol that appears to the left of 'subed' to get to the Symbol Selector. Click 'More Symbols' and click Geology 24K. Select the symbol to represent bedding and in the options box select size (40) and colour (orange) and make sure the angle is set to 270. Click OK.

In 'Layer Properties' click 'Advanced' ‑> rotation ‑> check the Geographic radio button, and in 'Rotate Points by angle...' select AZIMUTH. Click APPLY. Click OK and OK.

Repeat for 'foliation1', ‘foliation2’. 'dikes1, dikes 2', and faults.

PLOTTING STRUCTURAL LABELS

In 'Layer  Properties' select Labels. Check the 'Label features in this layer' box. In 'Method' select 'Define classes of features and label each class differently'.  In 'Class' select 'Get Symbol classes' to have the class value 'subed' entered as the class, and check 'Label features in this class. Enter 'DIP' as the Label Feld, and in the Placement Properties option box select low for 'Label Weight' and check 'Place overlapping labels'.

Repeat for 'foliation1', ‘foliation2’. 'dikes1, dikes 2', and faults.

The placement of the labels and their priority can be set in the Label Manager ‑ RC Layers ‑> Labeling ‑> Lable Manager, etc.

DRAWING LINES (GEOLOGICAL BOUNDARIES)

RC 'Layers' and 'Add a New Group'. Call it ‘Lines'. 

Click the ArcCatalog icon in the Toolbar (icon to the left of the red 'Arc Toolbox' icon. Click File ‑> New ‑> Shapefile. Give the Shapefile the name ‘all_lines’, select the feature type as 'Polyline', and set the coordinate system.( If you intend to use the ET Geowizards function to convert intersecting polylines to polygons you must set the Coordinate system in all shapefiles to be added  to ArcMap (ET Geowizards will not assume that the shapefile has the coordinate reference of the Data Frame.)  It is convenient therefore to place the current coordinate project file in the Coordinate Systems folder in \Program Files\ArcGIS  ‑ when creating your first or any shapefile (Catalog ‑> File ‑> New ‑> Shapefile) and when adding the 'Spatial Reference', save the selected coordinate system to C:\Program Files\ArcGIS\Coordinate Systems.  When adding another shape file the 'Spatial Reference' can then be easily retrieved with the Select button.)

Click OK. The new ‘all_lines’ shapefile will appear in the shapefile list in the catalog. Click and drag the shapefile into the 'Lines' group in the TOC. 

CONVERTING LINES TO POLYGONS AND TRANSFERRING SELECTED POLYGONS TO THEIR OWN LAYERS

Download ET Geowizards from:

http://www.ian‑ko.com/   ‑ ET Geo Wizards

http://www.ian‑ko.com/ET_GeoWizards/UserGuide/et_geowizards_userguide.htm  ‑ ET Geo Wizards online guide

Unzip ETGeoWizardsXX.zip ‑ the file contains a single executable 

Run ETGeoWizardsXX.exe ‑ a simple installation wizard will guide you through the process. 

The best location to install the files is the hard disk where ArcGIS resides or your system disk 

In ArcMap 

Click the Tools menu and click Customize.
Click Add from file button 

Navigate to the folder where ETGeoWizards941_9x.dll resides select it and click open 

In the added objects dialog box there will be a single object ‑ ETGeoWizards. Click OK 

Click the Commands Tab 

There will be new category ‑ ET GeoWizards ‑ click on it 

Drag the ET GeoWizards command to the Tool Bar.
With the ‘all_lines’ layer as the active layer draw your lines (boundaries) using the drawing tool on the Editor toolbar (Editor ‑> Start Editing ....). Save Edits and Stop Editing.

Create a Lithology group and a lithologic e.g. 'granite' polygon shape file; add the shape files to the Lithology group.

Click ET Geowizards in the tool bar, and in the Geowizards menu select Polygon -> Build Polygon -> Go -> select the all_lines layer as the input and ‘allpolygons’ as the destination file.. Make sure the option to ‘clean’ the polylines is selected. Click Finish to initiate the convertion

With the 'allpolygons' layer active, start the Editor and in 'Task' select 'Create New Feature' and in 'Target' select the e.g. granite shape file. Click the polygon (or 'Select by Polygon') to be copied to the relevant layer (use Shift select to choose several polygons). RC and select Copy. RC and Paste. Save Edits and Stop Editing. A copy of the selected polygon(s) representing granite bodies will now appear in the granite shape file.

To make the filled polygons transparent: RC Tools -> Effects -> indicate which layer you wish to make transparent, click the ‘Adjust Transparency’ icon, and adjust the transparency.

Note: 1) the attributes of the original polygon will not be copied with the polygon; 2)  when in Edit mode the id fields of the lines and polygons can be manually edited; 3) when selecting a polygon by attributes use the format e.g. "SHORT_NAME" = 'AS'; 4) fields can be added to the attribute table of a shape file by going to Properties of the shape file ‑> Fields ‑> add a new field name (this can only be done after exiting any documents which contain references to the shape file).

What if I want to change the shape or position of part of a common boundary between two polygons where each polygon occupies its own layer (shapefile)?

Select Editor -> Start editing -> (select files from which you wish to edit data) -> More Editing tools -> Topology. Select  ‘Modify Edge’ under ‘Topology Task’ in the Task list (on the Edit toolbar). Left click the Map Topology icon (leftmost icon) on the Topology toolbar, and select the shapefiles to participate in the map topology, i.e. all the shapefiles containing features which include the lines you are going to change. Select the ‘Topology Edit’ tool in the Topology toolbar, and double click the line you wish to modify. Drag the node you wish to relocate to its new position, and single click in any blank space.  The line will now be relocated in all the polygon layers in which the line is a participatory drawing element. Save Edits and end the Editing session.  When you close ARCGIS the topological constraints set up during the Topological editing session will not be retained.  

IMPORTING LAYERS FROM AUTOCAD ‑ SUDBURY REGION SAMPLE

I have a .DWG file composed of layers representing geologic units hand‑copied as polygons on OGS map 2491 of the Sudbury region.  Each rock unit polygon has been placed on its own layer, with a separate layer for the vector 'hatch fill'.

There are also layers for faults, oriented bedding and structural symbols; bedding trends, rock unit boundaries, and younging directions; vector geographic entities such as reference coodinate points, coordinate grids, roads, railways, lakes, etc.; raster images such as airphotos, landsat images, and photographs; and text such as location names. 

Problem: to transfer the individual layers in Autocad to individual layers in ArcGIS9.

Procedure:

Freeze all the layers in Autocad except the layer for the e.g. Stobie polygon.


1) File ‑> Export ‑> 'File name' for the .DXF file e.g. map1 ‑>  'Save as type' 'Autocad R14 DXF' ‑> Save.  All the layers will be saved in the .DXF file (c. 10 Mb) but the file will record that only one layer is turned on.


2) File ‑> Export ‑> 'File name' for the .DXF file e.g. stobie ‑>  'Save as type' 'Autocad R14 DXF' ‑> Options ‑> check 'Select objects' ‑> OK ‑> Save ‑> select the objects to save (all or window the objects). Only the one layer (c. 35 kb) will be saved.


Load ArcMap and then ArcCatalog.


In the relevant directory of Arc Catalog, two 'map1' and two 'stobie' files/folders will be listed. 


The files represented by an uncoloured single document icon, contain in both cases the Stobie polygon (CAD drawing) without a coloured fill. If the folders are added as layers to ArcMap the layers will be titled map1.dxf and stobie.dxf. In the 'Drawing Layers' in the Properties of the map1.dxf layer are listed all the layers in the original .DWG drawing, whereas in the case of the stobie.dxf layer only the original stobie layer is listed.   

The folders represented by a blue coloured muti‑document icon (CAD Feature Dataset), contain lower level files referenced as annotated, multipatch, point, polygon and polyline folders. Adding the polyline and polygon data files to the TOC creates layers titled 'map1.dxf polyline' ('stobie.dxf, polyline') and 'map1.dxf polygon' ('stobie.dxf, polygon'), respectively. The former displays only the outline of the polygon whereas the latter displays both the polygon outline and its fill.

In all cases the layer data will not be georeferenced. In order to georeference the layers they will have to be exported as shapefiles using the option 'Use the same Coordinate system as the Data Frame' (will need to set the coordinate system of the Data Frame).

If the  map1.dxf and stobie.dxf files are erased, the map1.dxf and stobie.dxf folders will also be erased, implying that the files and folders are not independant data entries.

To conserve disk space, the best best option would seem be to export individual layers from Autocad as filtered ('select the objects to save' option) DXF files. Add the polygon file to ArcMap and resave to a new shapefile, e.g. stobiepolcoord. Clear all files except the latter.

MISCELLANEOUS

When you are in layout view and want to draw graphics on a data frame so they display with your data, it is not necessary to switch to data view first. Instead, click the Select Elements tool on the Draw toolbar and double‑click the data frame. This gives the data frame focus. Now when you draw graphics on the data frame, they'll be added to the data frame instead of to the map layout. Once you've finished, click outside the data frame with the Select Elements tool to unfocus the data frame. Graphics you add to a focused data frame in layout view will also show up in data view. However, any graphics you draw in layout view that are not being added to a focused data frame, only appear in layout view.

To add a Legend, North arrow, or scale bar, when in Layout mode, click insert ‑> North Arrow

Note from Deborah Lemkow of the GSC: “Regarding projections. Getting a projection through the data > export data option is not always the best way to go, as it isn't that accurate. For the students it is probably fine. However, if you were working as a consultant and doing mapping at 1:50 or more detailed, I wouldn't use it. Especially if you were dealing with discrete interfingering layers. Most of the people using GIS aren't as passionate about projection inconsistencies as maybe we are here at the GSC. The whole issue has really come to light now that the satelites can give us such great accuracy through the gps.”

Using GPS with ARCGIS9

RC Tools and select GPS to display the GPS toolbar. (Connect Belkin RS232 to USB converter before turning on the computer.) Click GPS Connection setup and set the com port (Use 'detect GPS Port" to determine port being used).  Make sure the datums correspond on the computer and the GPS unit.

Exporting a part of the image

The data in an ArcGIS World File has the form: 

           15.0000000000

            0.0000000000

            0.0000000000

          ‑15.0000000000 328848.5000000000 4888582.5000000000

where

15 = [X‑Scaling; meters]

0 = [Rotation] 

0 = [Translation] 

‑15 = [Y‑Scaling; meters] 

328848.5 = [UTM Easting of 1,1] 

4888582.5 = [UTM Northing of 1,1]

Correct plotting of the image also requires that the Tiff image have embedded as a Tag the information, e.g. 

10 S (UTM) = [UTM Grid Zone or Coordinate System PCS Number] 

NAD27 CONUS  =[Datum] 

The exported image will be whatever can be seen on the screen at the time of export.

To Export, click File ‑> Export Map ‑> the General tab at the bottom of the Export dialog box. 

Optionally, to add georeferencing information, check the Write World File box. This option is only available when you export while in data view and will create an additional file called a World File that contains information that is used in conjunction with the exported raster file to tell software where the image is located in the world. The file will have the same name as the image file and a file extension that is based on the first and last letters of the image's file extension plus the letter "w". (For example, if you create a TIFF image called "MyMap.tif, the world file will be called "MyMap.tfw".) The datum information will be retained in the Tiff file tag, and not in the World File.

At this stage you can also change the resolution of the exported map from the default value of 96 dpi.

Optionally, the TIFF file format has the ability to store georeferencing information internally. This is called a GeoTIFF. To create a GeoTIFF, click the Save as type dropdown arrow and click TIFF, click the Options arrow to expand the options, then click the Format tab and check the Write GeoTIFF Tags box. These options are only available when you export while in data view.

Reference points for campus image:

Top left 

477 700, 4761 900

Bottom left 
477 700, 4761 600

Top right 

478 000, 4761 900

Bottom right 
478 000, 4761 600
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